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1 General

The system software TERM-L5 is used for configuration of power analysers

LMG95/LMG450, transfer and visualisation of measured data. The measured values can be

stored as ASCII-File either on the hard-disk of an conventional PC or at the special network

data logger NDL5. It is possible to measure all values which are available in a LMG. The

resolution of the recording can differ from the measurement cycle of LMG and is settable up to

1 hour.

2 Configuration of measuring set-up

The input signals (voltages and currents) as well as additional analogue and digital signals are

measured with a power meter LMG. There are two ways to store the measured values. One

can use an usual PC. The data transfer is working via USB or GPIB link. In this case the

measurement will be started from PC by TERM-L5. While measuring you need a PC to fetch

the data and save it on the hard disk. The measurement process can be stopped from TERM-

L5, only.

The more comfortable way to measure and save the input signals is usage of a network data

logger NDL5. In this case you don’t need a PC close to a LMG. You configure the

measurement and start it either over Ethernet or manually. The data will be saved on the hard-

disc of NDL5.

Fig. 1
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The main purpose of the TERM-L5 is to configure the LMG and to perform a long term data

logging. While operating with TERM-L5 the user is able to carry out the following tasks:

� Setting up the parameter of measurement as measuring ranges, thresholds, resolution etc.

� Defining what configuration (direct measurement or NDL5) is intended to use

� Starting the measurement

� Logging all the available values with the settable resolution and capturing waveforms

� Asking a status of measurement projects while using a NDL5

� Stopping the measurement while using a USB or GPIB link.

3 Hardware requirements

You need (at minimum):

� Pentium 233 MHz

� 32MB RAM

� Win 98, Win NT, Win 2000 or Win XP

� Graphic resolution 1024x768

� About 10MB memory for configuration software, DLL’s and drivers

� Hard disk as required

The recommended configuration:

� Pentium III 1GHz

� 64 MB RAM

� Win 98, Win NT, Win 2000 or Win XP

� Interfaces: Ethernet, USB or GPIB

� Resolution 1024x768

� About 10MB memory for configuration software, DLL’s and drivers

� Hard disk as required
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4 Installation

The software is delivered on CD-ROM. There are TERM-L5 software package as well as

VISA driver on this CD-ROM.

If you are going to use a direct connection between LMG and computer, you should install the

VISA driver before installing TERM-L5 software. You find the VISA driver in the directory

„\VISA26\“. Start this file to install the driver. If you have already installed the VISA-driver

2.5 from National Instrument or a driver from Agilent or Tektronix, take care that you have to

remove it from your system to guarantee a correct operation of TERM-L5. You are able to do

this by using the uninstalling tools of MS Windows.

For installing the TERM-L5 software start „\TERM-L5\SETUP.EXE“. If you have already

installed a previous version, it will be uninstalled automatically. After uninstalling start the

setup.exe again to install the new version.

After installation you have to reboot your computer.

5 Starting the TERM-L5

The following window appears after starting the TERM-L5.

Fig. 2

5.1 Starting direct measurement

Important: You need a correct connection between your PC and LMG450. If you use a serial

connection or an USB link, then the following parameters must be set at the LMG450:
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Device: COM A with a 1:1 RS232-Cable or COM B with a NULL-

Modem Cable

Baudrate: 38400, 57600 or 115200

EOS: <lf>

Echo: Off

Protocol: RTS/CTS

The LMG communicates with PC by RS232. If you want to use a USB port of your PC for

data logging, you have to use a special USB-RS232 cable.

In this case you must install the specific driver of the USB-RS232 cable. After installing, the

USB-link will be used as an additional virtual serial port.

If you are going to use the GPIB-Link, you have to set up an appropriate address at the LMG.

After choosing “Starting direct measurement” the automatic search of all available devices will

be started. The connected measuring devices which are capable to operate with TERM-L5 will

be shown.

The identification data, available clamps and options of the LMGs which are found, will be

shown at the window (Fig. 3)

Fig. 3

After choosing the device, which will operate with TERM-L5, you must double click on this

line to start configuring measurement.
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 The configuration is described in section 6. The description of measurement process is given

in section 7.

5.2 Working with NDL5

First of all you have to connect a LMG with a NDL5 by means of the serial cable. The

following interface setting must be used.

Device: COM A

Baudrate: 115200

EOS: <lf>

Echo: Off

Protocol: RTS/CTS

After connecting LMG and setting the interface parameters you need to switch NDL5 off/on in

order to identify a LMG

While working with NDL5 you can choose between two possibilities within TERM-L5.

5.2.1 Configuring and starting a new project

After choosing this line and double clicking it you have to choose the filename for the data

logging. Take care that it must be a NDL5 disk drive. After choosing it, the TERM-L5 will

identify a LMG connected to the NDL5 as shown at the Fig. 3.

5.2.2 Controlling and stopping existing projects

Here you have an opportunity to survey all projects situated on the hard disk of the NDL5.

Double click onto the second line in NDL5 box (Fig. 2) to choose an appropriate drive. Then

the following table appears (Fig. 4)

Fig. 4

By double clicking the project with the status “running” you will stop the data logging. The

second way to stop the data logging is to push the “stop” button of the LMG.
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If you wish to remove all files from hard disk drive, you have to click the right mouse button.

However the logging must be already stopped.

6 Configuring the measurement

After choosing the kind of the TERM-L5 operation and selecting a logging file, you are able to

set up the configuration of a LMG as well as the parameters of logging. This chapter is valid

either for direct operational mode or for operation with NDL5. The configuration procedures

with TERM-L5, which are described in the chapters 6.1 to 6.4, completely correspond with the

setting of the measuring configuration at the LMG. That is why it is strongly recommended to

read the appropriate chapters of the LMG manual for better understanding of each parameter

to be set.

6.1 Setting measuring ranges

The property page for settings of the measuring ranges is presented at Fig. 5. The number of

channels depends on the measuring instrument, you use. There are four current and four

voltage channels with LMG450, and one current and one voltage channel for the LMG95. The

current clamps which are connected to an LMG will be recognised automatically and the

measuring ranges will be fixed according to the recognised configuration. If you changed the

clamps, it is recommended to switch the NDL5 off and on again and repeat a procedure

beginning with the chapter 5.

Fig. 5
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6.2 Setting measuring parameters

The property page  „Measure“ (Fig. 6) is earmarked for the setting of measuring parameters.

Use the switch „Measuring mode“ to select it. You can find the detailed description of these

parameters in a user manual of the measuring device.

Fig. 6

6.3 Setting triggering parameters

You can set up the triggering conditions for synchronisation in the normal measuring mode as

well as in “HARM100”. Choose Xtrig in the field „Coupl“. The appropriate window (Fig. 7)

allows you setting of the triggering signal (1), filter (2), level (4) and hysteresis (5). Confirm

the setting with „OK“-button (3). You have to read carefully the description of the triggering

parameters, because an incorrect set up may impact measuring results.

Fig. 7
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6.4 Setting the analogue inputs

On the property page “Analogue Input/Output” (Fig. 8) you can configure the parameters of

analogue inputs of the LMG. The detailed description you will find in user manuals of the

LMG.

Fig. 8

6.5 Using the formula editor

On the property page “Custom” (Fig. 9) you can edit the formula to load it into LMG. Take

care, that:

� Each string ends with semicolon (3);

� <Ctrl-Enter> is used to start editing a new line;

� after editing a last string you have to enter  <Ctrl-Enter> again (2).

The formula will be transferred into LMG after starting the measurement. An existing formula

will be deleted.

Fig. 9
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6.6 Transferring and saving measured data

On the property page “Transfer and Saving”  (Fig. 10) you can configure transfer and saving

operations.

Fig. 10

In the step mode you can choose the way of data reading (1). If you choose INIM, the

measured data will be obtained at the end of the cycle. This will take up to one complete cycle.

Please, read the explanation of INIM and COPY commands in user manual for the measuring

instrument. The control box LEN activates the “local enable” operational mode. It means the

keyboard of the LMG is available while logging the data. These setting options are available

for the operation without NDL5 only.

Within a field “Data set every” (2) you can set up the resolution of data logging you wish. It

can be independent from the cycle time of the LMG. The kind of value to be logged can be

chosen with the slider “Grouping of measured data” (3). There are following values available:

� None. The last value over a measured cycle of a chosen logging period will be saved.

� Average. The average value will be saved

� Square. The result of square averaging of measured values from each measuring cycle

over a logging period

� Min. The minimum value of the measured values from each measuring cycle during the

logging period

� Max. The maximum value of the measured values from each measuring cycle during the

logging period

You can also choose a kind of the separator between two data columns and a format of data

(in accordance with settings of MS-Windows) with the controls “Separator” (6) and “Format”

(8). The field “Format” sets the kind of the decimal divider. If you choose “English”, it will be

“.”, if you choose “German” it will be “,”.
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The control box “Header” (4) defines, whether the  names of measured values will be saved in

the first row. By clicking the control box “Time column” (5) you can define, whether the time

column will be saved.

By means of the setting in the field “File size, lines” (7) you can manage the saving process in

order to avoid files with very large sizes. The measured data will be saved in a number of files

with the name “file_XXX.txt”, where XXX is a number 0,1,2,.... The first data sets will be

saved in the file named file_0.txt. After reaching the set limit this file will be closed and the file

named file_1.txt becomes the target of the logging.

6.7 Starting and stopping the logging automatically

On the property page “Start/Stop” (Fig. 11)  you can choose the duration of the measurement,

by clicking “Autostop” (2) control. In this case the measurement will be started by pushing the

“Measuring” button and will be stopped automatically after the measuring time from (5) is

over. If you use the “Start/Stop automatically” (1), you can enter the date and time of starting

(3,4) and finishing (6, 7) of the measurement. The start and stop can also be synchronised with

external digital inputs of a LMG. The combination of the different conditions for start and stop

can be set up in the fields 10 and 11. The activating of the box 8 “Start signals during transfer”

means that the data logging will be started if the digital input values correspond to the values

from 10 and the logging will run as long as these values will stay the same.

Fig. 11
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6.8 Confirming settings

Confirm the new settings by means of „OK“ button. These settings will be transferred into

LMG during the initialisation. If you use the measuring set-up with  NDL5, the configuration

will be saved in the NDL5. Each time you turn NDL5 on the data logging will start

automatically. You can load and save the configuration from the menu point “Setup -> Save”,

“Setup->Load”.

7 Choosing measuring values to be transferred

After confirming setting the program will show a main window (Fig. 12).

Fig. 12

First of all, you must choose the required measuring quantity in the list box “Sign.Chan.” (18)

on the left. By using a right mouse button you can select a required channel of LMG. (If you

have LMG95, only one channel is available). If you insert one of the vector signals (harmonics

or variables), you have to enter start and finish indexes in the field 20.
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By double clicking on the chosen item it will be inserted in the list of data to be transferred.

The name of the chosen signal appears in the list box  (17) on the left, above. Now you can

determine, whether this signal will be plotted. You have to mark this item and to choose the

number of the plot by clicking a right mouse button. There are six strip charts you can use.

You can remove one or more items from the window of measured data by pushing “Delete

item” (1) (one item will be removed), “Delete same” (2) (the same signals will be deleted, for

example all harmonics) or “Delete all items”  (3) (all items will be removed).

The same can be effected by the menu points “Edit->Delete Item”, “Edit->Delete same” and

“Edit->Delete all items”.

The appropriate short command will be generated in the box “demand line” (21) on the right.

8 Loading the measuring parameters and transferring the
measured data

After you inserted one or more values to be measured into the list of transferred values, you

can start initialising of the LMG.

8.1 Using a direct connection LMG-PC

If you work without NDL5 there are two different operational modes available, which can be

chosen by means of. In continuous mode, which can be activated with the button “Continuous

measuring mode” (6) or from the menu point “Operational mode->Continuous”, the measured

data will be transferred uninterruptedly. In step mode (either the button “Step measuring

mode” (7) or the menu point “Operational mode->Step mode” you are able to obtain the data

at the desired moment.

The data acquisition will be prepared either after pushing “Connect and initialise the LMG” (9)

button or from menu point “Run->Init LMG”. The button “Start measurement” (10) becomes

active. The data transfer can be started by clicking this button and will run until the “Stop

measurement and disconnect a LMG” button (12) is pushed.

The measured data are displayed in the window “received data” (22). The first two columns

represent current date and time, the next ones display received data.

In step mode data set will be obtained each time you push the “Start measurement” button

you can finish the acquisition by clicking a “ Stop measurement and disconnect a LMG ” (12)

button.
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Fig. 13

If you have defined the measuring values to be plotted, then the panel with six strip charts will

appear after starting of the acquisition (Fig. 13). The X-axis represents time in continuous

mode and number of measurements in the step mode. You can switch to main window by

means of the button “Go to main panel”. Using menu point “View->View plot/Hide plot” or

the buttons “View plot” (13) and “Hide plot” (14) you can display or hide the panel with the

plots.

For saving measured data, you can use menu point “Notebook” or button “Show and edit the

notebook” (16) to write some comments while measuring. It will be saved in the file named

“filname.not”. “Filename” is the name of your logging file. If you save the data into the file

“my_project.txt”, the comments will be saved into the file “my_project.not”.

8.2 Using a set up with NDL5

While working with NDL5, the measurement will start immediately after initialisation. If there

are running projects, then they will be stopped before the start. After initialisation you can quit

TERM-L5. The saved data are to be analysed with usual tools like MS Excel. The measured

data are also available during logging. However the minimum instant of saving equals to 4kB.

As long as the file size is smaller than 4 kB it can’t be analysed while logging.

9 Transferring the sampling values

It is possible to transfer sampled values of current, voltage and power in the step- and

continuous mode. You have to activate this mode with the button 8, Fig. 12.
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9.1 Using a direct connection LMG-PC

First of all you have to initialise the LMG as described earlier. If you use the continuous

logging the following window will appear after initialising (Fig. 14).

Fig. 14

If you use a step mode, this window will appear each time you push the “Go” button. In this

window you can set up the pre- and post triggering time for the sampling values and choose

the signals to be transferred. By using the button “Set parameters of LMG scope” (4, Fig.12)

or from menu point “Edit->Scope parameters”, you can set the sampling frequency and the

length of data buffer of a LMG as shown at Fig. 15. You are able to change the number of

recorded cycles and the recorded signals only. The sampling frequency and available recording

duration will be calculated automatically.

Fig. 15

After pushing “OK”- button from the panel “Data available” the waveforms will be transferred

into your PC.
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If you are working in continuous mode, then you have to push the “Go”- button only one time.

The waveforms will be transferred periodically until you will stop logging.

Waveforms which were transferred can be presented both graphically (Fig. 16) or as table (Fig.

17).

Fig. 16

Fig. 17

9.2 Using a set up with NDL5

While using NDL5 there is following way to log the waveforms. First of all you have to set up

configuration of the scope of a LMG as described above (Fig. 15).

Then you push “Initialise button”. Now the panel “Data available” (Fig. 14) appears.
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You set up the pre- and post triggering times as well as the signals to be transferred and push

the button “Continue”. The configuration will be transferred into your NDL5.

The NDL5 is now waiting to log the waveform.

Each time you push the “Start” button of LMG the sampling values will be transferred and

saved.

After pushing the “Stop” button the logging will be stopped

10 Converting saved data into MS Excel

The measured values can be saved in ASCII format. In order to convert it into MS-Excel

format you have to carry out the following steps:

1. Check, whether the decimal point of the saved data corresponds the decimal point of MS

Windows. If not, set the appropriate decimal point of MS Windows.

2. Start MS Excel.

3. Load the file with measured data. You have to set “Text file” at the window “File open”

(Fig. 18).

Fig. 18

4. Follow the instructions of the Text-Wizards (Fig. 19a). It is important to set-up the

following parameters:

� Step 2. The separator between the columns must correspond the one from TERM-L5 (Fig.

159 b);

� Step 3. All columns must be formatted as “standard” (Fig. 19 c)

Converted data (Fig. 20) can be proceeded with MS Excel tools.
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Fig. 19a

Fig. 19b
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Fig. 19c

    

Fig. 20

11 Transfer problems with weak computers

With weak computers you might get transmission errors, depending on the used capacity of the

machine, because the amount of data to be transferred, displayed and stored is huge.

To prevent this you may deactivate graphical indication.

You should also remove all programs as possible from the status line of Windows.
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Due to Windows is not a real time system, you also might get problems, if there are any other

background activities. For example you should not move any windows while transferring data.

Screen savers and energy save modus are critical.

Some computers using Windows have problems with the set up of the receiver FIFO buffer

interrupt of the COM interface. This can be set up from 1 to 14. Depending on the amount of

background processes you might try several values.


